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How To Keep My Mailbox 1 Tidy And Organized
How To Organize My Mail With Folders
The fewer emails you have in your Inbox, the faster Lotus Notes will respond. To
achieve this, you can create folders to organize your email and therefore reduce
the number of messages in your Inbox. The other primary benefit to this is so
that you know where to find your old messages when you need them.
To create a folder:
1) Select Folder from the Create menu.

1

Your mailbox consists of your Email (All messages in every folder including the Trash), your Calendar and To Do.
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2) Type in the folder name and click Ok.
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Once you have your folders created, just drag and drop emails into the relevant
folders or select the emails you wish to move, use the Folder Icon button above
your list of emails and select Move to Folder… to organize them.

You c an al so do t he s ame for m ultiple em ails at onc e. P lease s ee Selecting
Multiple Messages.

What To Do When I Get Mail
Once you have read an email and read it you should do one of the following:
• Delete the email
• Move it to a folder (if you need to keep a record)
York University
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This will he lp t o ens ure the num ber o f m essages i n your I nbox i s kept t o a
minimum. Your Inbox will also become a list of items that need ac tion. You will
immediately know what needs your attention.

What To Do When I Get Mail With Attachments
Once you have read an email and read it you should do one of the following:
• ‘Delete’ the email
“I don’t need the email or the attachment.”
• ‘Delete’ the Attachment and ‘Move’ the email ‘to a folder’
“I don’t need the attachment but I need the email for future reference.”
• Save the attachment to a network drive for your department, ‘Delete’ the
attachment from the email and ‘Delete’ the email
“I need the attachment for work but I don’t need the email”
• Save the attachment to a network drive for your department, ‘Delete’ the
attachment from the email and ‘Move’ the email ‘to a folder’
“I need the attachment for work and I also need the email for future
reference”
NOTE:
If you want to keep an attachment that is of a personal nature, DO
NOT save it to a net work drive. P lease ‘Save’ such attachments locally to your
My Documents folder o r forward t he at tachment t o y our per sonal em ail. O nce
that is done ‘Delete’ the attachment or the email.
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What To Do With Attachments
Deleting Attachments & Keeping The Email
1) Right click on the attachment and select Delete…

2) When prompted for confirmation, click Yes.

3) When you close the email you will get prompted to save. Click Yes.

4) Move the email to a folder for future reference.
York University
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Saving Attachments Outside of My Mailbox
1) Right click on the attachment and select Save and Delete…

2) Select the location you want to save the attachment to from the Save in:
drop-down box
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3) Browse to the folder you wish to save the attachment in by doubleclicking on the relevant folders in the list
4) Once you are in the desired destination folder, click on Save.

5) When you close the email you will get prompted to save. Click Yes.

6) Delete the email if it is no longer needed OR Move the email to a folder
for future reference.
NOTE: If you want to keep an at tachment that is of a per sonal nature, DO
NOT save it to a network drive. Please save such attachments locally to your
My Documents folder or forward t he at tachment to y our pe rsonal e mail.
Once that is done ‘Delete’ the attachment or the email.
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Replying Without Attachments
This w ill pr event t he c onsumption o f s pace w ithin y our ow n m ailbox as w ell as
the destination mailbox by omitting unnecessary attachments.
1) Click on the Reply or the Reply To All button above your email
2) Select Reply with History Only

NOTE:
This i s es pecially us eful w hen t here i s a c hain o f replies t o a n
email that has an a ttachment. In this case all the replies in your sent folder and
in your Inbox would contain the attachment. If the attachment is 1MB in size and
you r eplied 10 t imes t o 9 r eplies f rom the s ender y ou end up with 2 0MB ( 1
original message + 10 responses in your Sent folder + 9 replies back from the
other person) of space consumed in your mailbox.
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How To Clean Up My Mailbox or Archive
Why Should I Clean Up My Mailbox or Archive? Quotas
The more mail in your mailbox the slower your email will be due to the increasing
load on y our mailbox. Just like a word file that keeps growing in pages, it takes
longer to load and manage.
Quotas are set at 500 MB for your Mailbox. Note: your mailbox consists of your
email (all messages in every folder including the Trash), your Calendar and To
Do list. N o quota increases are granted – clean up or use the Archival system.
If you are over quota the system will send you an email every 4 hours. When
you are over quota both Mail and Calendaring functionality will be limited. If you
are approaching quota you will receive the system will send you an em ail every
24 hours.
You can see the current size of your mailbox by click the Tools menu then go
down to Quota Information…

Deleting Mail
1) Select the mail messages you wish to delete.
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2) Press the Delete button on your keyboard, or click on the Trash icon or right
click and scroll down and click on ‘Delete’.
You can select multiple messages to be del eted at once. P lease see Selecting
Multiple Messages.
NOTE: If you have a l arge number of messages to delete it's best to delete less
than 300 messages at one time. The number of selected messages is displayed
in the lower left corner of the Lotus notes window.

Deleting Sent Mail
Lotus Notes saves a copy of every email you send and keeps it in the Sent
folder, attachments and all. As you can imagine, the Sent folder will consume a
lot of space over time. It is a good practice to periodically delete sent emails you
no longer require. Also, be especially mindful to delete sent mail that has large
attachments as described above. You may have years of old emails that are no
longer needed i n y our S ent folder. U se t he method abov e t o s elect and del ete
messages in your Sent folder or request an Archival set up.
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NOTE: Just as in the Deleting Mail section please do not delete more than 300
messages at one time. The num ber o f s elected m essages i s di splayed i n t he
lower left corner of the Lotus notes window.

Deleting Messages With Large Attachments
Attachments can easily consume the majority of space in your mailbox. Because
of this, management of your attachments is particularly important. You should go
through eac h o f y our folders and det ermine w hat t o do w ith t he at tachments
therein. Please see sections What To Do When I Get Mail With Attachments
and What To Do With Attachments for i nstructions on how t o manage
attachments. You can sort the emails in a folder by size and deal with the largest
ones first. At this point you could select multiple messages (see section Selecting
Multiple Messages) and delete them or deal with them individually. Here is how:
1. Click on the folder you want to work on in the left pane.
2. Sort the emails on the right by clicking on the Size column header. If this
column is not visible click on ‘Sort by default”, top right corner and then
highlight ‘(hidden) Size’. This will sort it in descending order of size.

NOTE:

Be sure to do this in each of your folders.

NOTE:
Just a s in t he Deleting Mail section pl ease do not del ete more
than 300 messages at one time. The number of selected messages is displayed
in the lower left corner of the Lotus notes window.
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Deleting Folders

IMPORTANT: You must delete all emails in a folder before deleting the folder.
Please think of a folder in Lotus Notes as a receipt that tells you where you
parked your car (email). If you lose (delete) the receipt (folder) it does not mean
your car (email) has vanished. You can also walk all over the parking lot
(mailbox) and eventually find your car (email) without the receipt (folder).
To delete all messages in a folder:
1) Click on the Folder in the left pane.
2) Click on any email in the right pane.

3) Press Ctrl + A on your keyboard OR Click on the Edit menu and select
Select All to select all messages in the folder.

4) Press Delete on your keyboard.
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If you deleted a folder before deleting all the messages onl y the folder name
would have been removed. All the emails remain in your mailbox. The only way
to r emove t he em ail i s to l ist al l the messages i n y our m ailbox r egardless of
folder and c omb through to find the ones that belonged to that folder and del ete
them.
To list all messages regardless of folder:
1. Click on All Documents in the left pane. All your messages will be listed
on the right.

Deleting My Old Calendar Entries
To delete old calendar entries:
1) Open your Calendar
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2) Click on the More menu and select "Calendar Cleanup…".

3) Specify the age threshold for entries to be deleted.

4) Select “Calendar entries” and “To Do entries”.
5) Click “OK”.
York University
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Emptying My Trash Folder
Deleting emails does not mean they are out of your mailbox just yet. They go to
your T rash folder. T his i s s o you c an r ecover deleted em ails j ust i n c ase y ou
accidentally deleted something you did not intend to.
Once y ou ar e s ure t hat t he i tems del eted a re i ndeed w orthy of del etion, y ou
should em pty t he t rash. T his will al low t he s pace t o be r eclaimed and y our
mailbox size will be reduced once the server compacts your mailbox.
To empty the trash:
1) Click on the Trash folder on the left.
2) Click on the Empty Trash button.
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Reclaiming Space From My Housekeeping
(Compacting of Your Mailbox)
After you have deleted emails/attachments and you have emptied your trash your
mailbox s ize will not i mmediately dec rease.
The “ free s pace” c reated from
emptying y our t rash i s r eclaimed by Lot us N otes i n i ts c ompacting pr ocess.
Compacting oc curs aut omatically ev ery Fr iday for m ailboxes t hat hav e 10% or
more “free space”.

Miscellaneous
Selecting Multiple Messages
Please pay careful attention to this section as it will assist you in doing many of
the things described in this document in a more efficient and less time consuming
manner. This is useful when deleting or moving several messages at once.
To select all messages in a folder, open the folder then press CTRL+A OR go to
the Edit menu and click on Select All.
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You can also select multiple emails at once by individually clicking in the white
area just to the left of the email to select it (a checkmark will appear for each of
the selected messages).

To select several consecutive mail messages click and drag up or down in the
white area to the left of your message l ist ( checkmarks w ill appear f or the
selected m essages). You c an al so achieve t he s ame r esult by c licking on a
message then holding down the shift key while pressing the up or down arrow on
the keyboard.
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Setting Your Email Signature
An email signature is a short bit of information that gets appended to the end o f
every email you s end. Because it is on every em ail you send, the signature
needs to consume as little storage space as possible. We recommend that only
text bas ed c ontent be i ncluded i n y our s ignature. T ypically, peopl e us e this t o
provide their name and contact information.
To set your email signature:
1) From the Actions menu, select More and click on Preferences…

2) Click on the Signature tab.
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3) Check the box for Automatically append a signature to the bottom of
my outgoing email messages.

4) Make sure T (Text) is selected.

5) Type your signature in the space provided and click OK.
NOTE: It i s pos sible t o hav e a m ore el aborate s ignature, how ever t his is not
recommended. This would involve creating a s eparate file on your computer in
HTML (W eb) format. Thi s signature will only be usable from the computer that
this HTML file is stored on and is not available from webmail. An HTML signature
will greatly increase the storage space used by each and ev ery email you sent,
especially if an image is included.
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Exporting Messages
You can save an individual message or multiple messages to a single text file on
your computer by using the export function.
1) Select the message(s) you wish to save
2) From the File menu Click on Export…

3) Enter a File name and leave the Save as type: “Structured Text “
4) Select the Location you wish to save it to in the Save in: drop-down box.
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5) Browse to the folder you want to save the file in using the list.
6) Provide a File name and Click on Export.

You will be able to open the resulting saved file with Notepad or any other text
editor application.

Archiving
Your archive mail file quota is 4GB. Archiving may be requested for all
mailboxes. 365 days is the standard archiving policy but upon request, can be
set to either 180 or 90 d ays. This means, all messages older than xxx days will
be moved out of your mailbox folder structure and placed into your archive with
an identical f older s tructure. These messages can easily be accessed by
opening your archive.
This will help to keep your primary mailbox small, speedy and efficient.
To open your archive via the Lotus Notes Client:
1) Click on Archive in the left pane.
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(2) Click on Archive Criteria – XXD - XXX
Archive Quota
Go to File  Application  Properties;
Then click on the Information Tab, and you will see Disk Space used...then click on the
percentage used; then multiply the disk space by the % used to get the size
i.e. 409 * .961 = 393 MB
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To open your archive via the Web:
Open an Internet browser and go to the address
cashel.notes.yorku.ca/archive/a_<your email username>.nsf . Please
substitute your actual email username for <your email username> in the
address given. For example, If your email is jchue@yorku.ca the address
for your archive will be cashel.notes.yorku.ca/archive/a_jchue.nsf .

7RGRZQORDGWKLVPDQXDORUWKH/RWXV1RWHV:HEPDLOYHUVLRQRIWKLVPDQXDO
SOHDVHYLVLW
KWWSFRPSXWLQJ\RUNXFDILOHV/1B/RWXVB1RWHVSGI
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